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About This Manual 
 
This manual describes BEDASTM a professional level bridge dynamic analysis under 
moving loads program, with capabilities to handle most typical 2d mechanics, aeronautics 
and civil/structural analysis problems. It performs static, mode shapes and dynamic 
response analysis. It gives exact high frequencies and mode shapes with only one element 
per beam (span). Dynamic finite elements lead to higher precision of internal forces in any 
location of structure excited by fixed, moving and/or seismic loads. 
 BEDAS is a stand-alone application with many advanced engineering functionalities. 
 
This manual is divided in six chapters: 
 
Chapter 1 Installation 
This chapter describes system requirements and gets you started installing BEDAS TM 
software. 
 
Chapter 2 Overview of BEDAS environment 
This chapter presents the environment and basic functionalities of Beam Designer. 
 
Chapter 3 Step-by-step menus 
This chapter presents a step-by-step example to show most functionality of BEDAS from 
starting the application to printing results.  
 
Chapter 4 Commands and Toolbars 
This chapter presents an overview of the operations of BEDAS and a summary of the 
commands used.  
 
Chapter 5 Components and Tips 
Using practical examples, this chapter presents an overview of the operations of BEDAS 
components and tips used in sketching and designing beam structures.  
 
Chapter 6 Techniques and conventions 
This chapter discusses the numerical methods implemented in BEDAS followed by some 
interesting examples. 
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Installation 

 
 

System Requirements 
 
BEDAS runs under Windows 98/Me/NT/2000/XP. It requires a Pentium class CPU or better 
and a minimum of 64 MB memory is recommended. The software requires 20 MB of free 
space on your hard disk. 
 

Installing Beam Designer 
 
To install Beam Designer, run the setup.exe program located on the installation CD.  
 

 
 
 

 
License Types 

After BEDAS files are installed, the final step in the installation is to inform BEDAS of 
your licensing information as printed on your invoice. The licensing information consists of 
a Name, either your name or the name of your organization or company, and a coded key. 
This information should be entered in the login dialog presented when you run the 
application for the first time. The software will check to see if the key is valid and if so, will 
record the information on your computer. BEDAS software is licensed either to individual 
engineers or to their companies or organizations. The license agreement is included with the 
software when you download or purchase it, and is posted on our web site 
www.mechatools.com. Essentially, the single-user license agreement states that you may 
use the software on one single machine, but that you must purchase additional licenses to 
allow others to use the software, on other machines. For more information, please contact 
Mechatools Technologies. 
 
 

Running BEDAS 
By default, the BEDAS installation program will create menu items in the Program Files 
directory. To run the program, choose Start | Program | MechaTools Studio| BEDAS. 
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Mechatools Team 
BEDAS is the easiest way for engineers to efficiently perform the dynamic responses of 
bridges under moving and fixed loads. BEDAS was developed by a professionals and 
engineers at Mechatools Technologies. This product was developed using state of the art 
methods in exact dynamic finite elements and sophisticated algorithms.  BEDAS is robust, 
scalable and very easy to use.  
 

How to Contact MechaTools Technologies Support 
The fast and efficient way to contact MechaTools for technical support is through email. 
Our technical assistance address is support@mechatools.com. For reporting problems, you 
may call or fax our office as well. Our office hours are 8:30AM - 5:00PM Eastern Time US 
& Canada (GMT-05:00). The technical support phone number is (418) 651.3689 and fax 
line is (418). 651.6456. 
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BEDAS Environment 

 
Environment 

 
The BEDAS environment is shown in the picture below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Main Menu 
 Main Toolbar 

Drawing Area (artwork area) 
 
 

Status Bar 
                    Tool Box 
 
 
MechaTools Studio is a working environment that supports various engineering tools. When 
you install a stand-alone version of BEDAS, you actually install MechaTools Studio with 
one engineering tool: BEDAS. 

Ruler 

Scroll bar 
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The main menu, toolbars, and status bar are standard Windows components. You can toggle 
the display of toolbars using commands in the View menu. The toolbox may also be 
“undocked” and moved in the program window from left to right by pressing right mouse 
button. The status bar at the bottom provides project information, hints and messages. It 
displays the current filename, the mouse position and the centroïd of the selected beams.  
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Chapter 3 
 
 

Step-By-Step menus 
 
 
 

Starting BEDAS  
 
Start BEDAS with the Start | Programs | BEDAS menu. 
 

Creating a New Project 
 
To create a new structure project, click the New Project icon from the toolbar or click New 
from the File menu. 
 
The Save As dialog is automatically displayed. Enter the name of you new structure project 
and click save. This dialog may be invoked at any time using the File menu. 

 
Setting the New Project Units 

 
The Units Transformation dialog is automatically displayed. Enter the units you will use 
to define the new structure. These units will be used for all work in Beam Designer. The 
Units Transformation dialog may be invoked at any time by clicking the Change Units 
icon from the toolbar or from the Options menu by clicking Change Units. Changing units 
does NOT change dimensions. A 1-inch edge becomes a 2.54 cm edge.  Click OK when 
you are done. 
 

 
 

 
Setting the Bounding Box 

 
The Working Window Boundary dialog is automatically displayed. This dialog is used to 
change the size and position of the bounding box. The bounding box is an imaginary box 
that surrounds a region of the drawing. Zooming operations are based on the size and 
position of the bounding box. For example, the Zoom All command resizes and moves the 
viewport so that the bounding box is centered and fully visible in the drawing area. After the 
Zoom All command is executed, the Zoom dropdown is set to 100%. BEDAS automatically 
resizes the bounding box when a beam manipulation causes a beam to exceed the bounding 
box limits. The user may change the bounding box manually to concentrate on a specific 
region of the drawing. The Bounding Box dialog may be invoked at any time by clicking 
the Changing Bounding Box by Mouse or the Changing Bounding Box Manually icons 
from the CAD and Data tab of the toolbox Options menu by clicking Change Bounding 
Box | Manually. Click OK when you are done. 
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Setting the Project Preference 

 
The Preferences dialog is automatically displayed. This dialog is used to associate structure 
specific information to the new structure project. Click the Identification tab to edit the 
project information. Generally, you may accept the default values for the Colors, Fonts and 
General tabs.  
The Color tab is used to set the color of various display elements: 
a) Beam identifiers 
b) Beam labels 
c) Point identifiers 
d) Grid 
e) Dimensions 
f) Dynamic responses visualization 
The Font tab is used to set the font of various display elements: 
a) Beam identifiers 
b) Beam labels 
c) Point identifiers 
d) Dimensions 
The preferences dialog may be invoked at any time by clicking on the Preferences icon of 
the toolbar or from the Options menu by clicking Preferences. Click OK when you are 
done. 
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The General tab is used to set various general-purpose properties: 
a) Number of real divisions per circle  
b) Relative thickness beam for visualization  
c) Loads draw width for visualization 
d) Deformation (solution) draw width for visualization 
e) The visual amplitude of the responses in effort (moment, shear, axial effort) 
f) Grids spacing ticks 
g) The ShapeDesigner software path (in option) for calculating complex geometric 

properties of sections 
h) The Twprofile Path (in option) for calculating complex geometric properties of thin-

walled open sections 
i) Output visual solution refinement  
 
The number of divisions per circle is used to specify the number of linear segments to 
approximate circles.  
 

 
 

 
 

Creating Beams 
 
From the Toolbox under the Geometry Input tab, click the beam icon. Then in the drawing 
area you can connect two nodes to create beam. 
 
 
 
 
 
 
 
 

 
 
 
 
 

Add beam 

Add node 

Add Arc from 2 points 

Add Arc from 3 points 
Parametric 
structures library 

Add one or 
some boundary 
conditions 

Delete selected:  node, nodes, 
beam, beams, boundary 
condition, boundary conditions 

Merge nodes with same coordinates 
 View Ids 
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1) Add Beam by selecting two exiting nodes. 
 

 
2) Add Arc from 2 points is used to create arc from 2 selected nodes and specified radius 
 

 
 
 
3) Add Arc form 3 points is used to create arc from 3 selected nodes. 
 

 
 
 
4) Parametric Structures Library is used to create parametric structures from the 

library. 
 

First selected node 
Second selected node 

Radius r 

First selected node Third selected  node 

Second selected  node 

Mouse position to 
locate the arc center 
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The method used to create beams and the number of beams required is specific to the 
problem to be solved. The following guidelines should be followed. 
 
1) BEDAS assigns material properties to beams.  
2) BEDAS automatically merge together common nodes. To detect common nodes 

boundaries, the distance between two boundaries is compared to a very small tolerance 
value (10-5). If this distance is smaller than the tolerance value, the boundaries assumed 
to be merged. Users should be very precise when assigning point coordinates. 

 
 

 
 

Creating Custom structures from data files 
 
Use this option to input a beam geometry using a text data file. The text file format must 
follow the rules below: 

1) The first line contains the number of nodes (n) followed by the number of beams (m). 
2) Each of the following n lines contains the x and y coordinates of a polygon point 

separated by a comma. 
3) Each of the following m lines contains the nodes beam connectivity i and j. 

 

Library browser 

Parametric 
dimensions  

Structure view 

Confirm to accept 
selected structure Accept selected 

structure  
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The following data file content describes a two beams structure: 
 
3, 2          // 3 nodes and 2beams 
0.0, 0,0   // x1, y1 
1.0, 0.0   // x2, y2 
3.0, 0.0   // x3, y3 
1 2          // beam 1 from node 1 to node 2 
2 3      // beam 2 from node 2 to node 3 
 

Selecting beams  
There are three ways to select beams.  
1) Using the pointer 
2) Using the Beams browser  
3) Sing Selection icon 
 
 
To select a beam using the pointer, move the pointer over the beam in the drawing area then 
press the left mouse button. The selected beam is shown in red. You can select more than 
one beam if you hold the Shift key down at the same time as you select beams by mouse. 
 
To select a beam using the Beams browser, select the CAD and Data tab from the toolbox 
and select the desired beam directly from the list using the mouse pointer. The selected 
beam is shown in red.  
 
To select multiple beams using a selection box, select the CAD and Data tab from the 
toolbox and click on the Selection icon. Drag the pointer, using the left mouse button, to 
draw a selection box around the beams you want to select. When you release the mouse 
button, all beams totally inside the selection box are selected. The selected beams are shown 
in red. 

 
Deleting Beams 

To delete beams, select the beams then press the Delete key or click the Delete Beam icon 
of the toolbar or from the Edit menu click Delete. A confirmation is always required to 
delete a beam. 

 
Moving Beams with the Pointer (or arrow keys) 

To move beams with the pointer, select the beams, then, from the CAD and Data tab of the 
toolbox, click Move Selected Beams by Mouse or from the Beam menu click Move. The 
selected beams become movable. Drag the beams using the left mouse button in the drawing 
area or using the arrow keys. When you release the left mouse button, the beams return to 
the unmovable state. If you want to move all beams, from the CAD and Data tab of the 
toolbox, click Move All Beams by Mouse. 
 
See the Moving Beams Accurately structure of this document for a more accurate method. 
 

Modifying Beams with the Pointer (Moving Nodes) 
To move a beam node, select the beam you want to modify, then, from the CAD and Data 
tab, click Modify Beam by Mouse or from the Beam menu select Modify Beam. The beam 
becomes modifiable. The beam nodes will be highlighted. Drag the beam nodes using the 
left mouse button in the drawing area. When you are done modifying the beam, click the 
right mouse button to return to non-modifiable state. See the Modifying Beams Accurately 
structure of this document for a more accurate method. 
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Zooming  

Zooming allows you to increase or decrease the size of the drawing viewport. There are four 
ways of zooming.  
1) Using Zoom In/Zoom Out icons of the toolbar or the View menu Zoom In/Zoom Out 

commands, you may increase or decrease the viewport by 10%. 
2) Using the zoom percentage dropdown you may increase or decrease the viewport by an 

arbitrary value. 
3) Using the Zoom All icon of the toolbar, you may readjust the viewport so that the 

bounding box is fully displayed and centered on the drawing area. See the Setting the 
Bounding Box structure in this document. 

4) Using the Zoom Window icon of the toolbar or the View menu Zoom Window 
command you may define a selection box with the pointer. Drag the pointer using the 
left mouse button to draw a selection box around the region you want to zoom. When 
you release the mouse button, the drawing area will be redrawn so that the selected 
region occupies the whole drawing area. 

 
Using the Grid 

To help position the pointer on the drawing area, it is possible to display/hide the grid. To 
toggle the grid display, from the toolbar click the Show and Hide Grid icon or from the 
View menu click Grid. 
 

Copying Beams 
There are two ways of copying beams: Using the Copy and Paste commands and using the 
Generate Beam dialog. See the Generate Beams structure of this document for description 
of the Generate Beam dialog. 
 
Select the beams you would like to copy. From the Edit menu click Copy or press CTRL + 
C. From the Edit menu click Paste or press CTRL + V. The operations actually performed 
by this sequence are: 

 
Rotating Beams 

To rotate a beam, select it and from the CAD and Data tab of the toolbox, click on the 
Transform beam icon or from the Beam menu click Transform. The Beam 
Transformation dialog is displayed. Click Rotate to display the rotation options. 
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Select the beam you want to rotate in the Beam to be Rotated structure. You may select a 
specific beam or All Beams. Note that the horizontal scrollbar in the Beam to be Rotated 
structure serves two purposes. If specific beam is selected, it is used to select the beam to be 
rotated. If All Beams is selected, it is used to select the About Point. Select the rotation 
type using one of the five options available: 
1) Free Rotation rotates the beam the specified Angle. 
2) Flip Vertical flips the beam around a vertical axis. 
3) Flip Horizontal flips the beam around a horizontal axis. 
4) Rotate Right rotates the beam clockwise 90 degrees. 
5) Rotate Left rotates the beam counterclockwise 90 degrees. 
 
In the case of rotation transformations, About select the rotation point. In the case of 
flipping transformations, About fixes the position of the flipping axis. About may be one of 
the following options: 
1) Point selects a specific geometric point of the selected beam in the Beam to be 

Rotated structure (even if a All Beams is selected). The point is highlighted in the view 
area. 

2) Centroid uses the centroid of the selected beam or the centroid of all beams as the 
about point. 

3) X-Y Axis uses the origin of the Cartesian coordinate system as the about point. 
Click Rotate to apply the rotation. 
 
The Beam Transformation dialog remains displayed for you to proceed to other 
transformations. Click Exit when you are done. Note that all transformations done in the 
Beam Transformation dialog are done in a single transaction and may be undone using the 
Edit menu and clicking Undo. 
 
 

Moving Beams Accurately (Translate) 
 
To move beams accurately, select a beam and from the CAD and Data tab of the toolbox, 
click on the Transform beam icon or from the Beam menu click the Transform icon. The 
Beam Transformation dialog is displayed. Select the Translate tab.  
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Select the beam you want to translate in the Beam to be Transformed structure. You may 
select a specific beam or all beams. Enter the translation values in the dx and dy textboxes. 
To align the centroid of the selected beams on the origin of the coordinate system, check the 
Align Centroid to X-Y Center checkbox. Click Translate to apply the translation. The 
Beam Transformation dialog remains displayed for you to proceed to other 
transformations. Click Exit when you are done. Note that all transformations done in the 
Beam Transformation dialog are done in a single transaction and may be undone using the 
Edit menu and clicking Undo. 
 
The Beam menu offers the Align Beam Centroid to X-Y Origin and the Align All Beam 
Centroid to X-Y Origin shortcuts. 
 

 
Modifying Beams (Moving nodes) Accurately 

 

              
 
To modify the nodal coordinates of a beam, select a beam and from the CAD and Data tab 
of the toolbox, click the Geometric Properties icon or from the Beam | Properties menu 
click Geometry. The Geometric Properties dialog is displayed. Click the Nodes tab. You 
may modify the displayed nodal coordinate. The Geometric Properties dialog may be left 
open while working. Its content is updated dynamically. 
 

         
 
 

Refreshing the Drawing Area 
To refresh the drawing area, click on the Refresh the Drawing Area icon in the toolbar. 
 
 
 

 
 
 

Refresh icon 
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Setting Material Colors 

It is possible to assign colors to materials. To do this, select the beams, and then from the 
CAD and Data tab click Set Beam Color or from the Beam menu click Colors. The Color 
dialog is displayed. Select a color and click OK. The color is assigned to the beam material. 
All beams using the same material will be affected by this change. To view beam colors, 
from the toolbar click the Show and Hide Beam Colors icon. 

 
Setting Material Properties 

To assign material properties to beams, from the CAD and Data tab of the toolbox, click 
Beam Material properties.  You may also click Material from the Beam | Properties 
menu. The Material Properties dialog is displayed. Select the Beam Materials tab. 
 

 
 
Select the beam to which you want to assign a material using the Beam Number horizontal 
scrollbar. For convenience, the beam Label is displayed and may be modified. Select the 
material type using the Material Type selection dropdown. The material properties are 
displayed. If your material type is not listed, select the User-Defined material type. When 
this option is selected, you may enter user-defined values for material properties. For user-
defined material types, enter the following material properties: Young’s Modulus, Poisson 
Ratio and Mass Density. If you want to use the same material type for other beams, check 
the beams in the Select for Same Material list. Click Apply to commit the current changes 
and keep the dialog open. Click OK to commit the current changes and close the dialog. 
Click Cancel to abort changes made since the last Apply and close the dialog.  

In BEDAS, it is included two components to compute the geometric properties of the 
beam cross-section, the standard steel section (library of the AISC) and the general 
parametric section. You can also using the ShapeDesigner software (in option) as a plug in 
with BEDAS for geometric properties of the complexes composite cross-sections. 
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At anytime you may select the Material Properties tab to get an overall view of material 
properties. 
If you do not explicitly define the material type, it defaults to the first material in the 
material database. 
 
 

Adding Labels to Beams (Notes) 
To add labels to beams, select the beam to which you want to add a label. From the Beam 
menu, click on view | Label…. The Set Beam Label dialog appears. Enter a textual label 
then click OK. Anytime you want to view labels, from the Dimensions tab click the View 
Beams Label icon or from the View menu click View Beams Labels. 

If we select section 
from the Predefined 

Sections tab, the 
section geometry is 
saved permanently 

We can also input 
directly the section 

properties. 

For special cross-
section click 

New section… . 

Standard Steel 
sections 

General 
parametric 

Steel sections 

Predefine and user-
defined material list, 

includes the yield 
stresses 
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Dimensioning Beams 
To view dimensions, from the Dimensions and Labels tab of the toolbox, click the View 
Dimensions icon or from the View menu and click Dimensions.  
 
To dimension beams, from the Dimensions & Labels tab of the toolbox, click one of the 
three dimension types icons: Horizontal, Vertical and Oblique. BEDAS switches to 
Dimension Definition Mode. Move the cursor over the first vertex point to dimension. When 
the point is selectable, a small circle appears around the point. If the pointer is correctly 
positioned on the point, the pointer changes to an arrow beam. Click on the left mouse 
button. Repeat the previous steps for the second vertex point. When the second vertex is 
selected, the dimension is displayed and it follows the cursor. Position the dimension with 
the mouse and click the left mouse button to lock it in place. 
 
When you are done dimensioning, click the right mouse button to switch out of Dimension 
Definition Mode. 
 

Editing Beam Dimensions 
 
To edit beam dimensions, click on the Edit Dimensions icon of the Dimensions & Labels 
tab of the toolbox. BEDAS switches to Dimension Editing Mode.  
 
To move a dimension, press the Move Dimension 
button and select the dimension from the drawing 
area by left mouse button. Move dimension to the 
desired position. Click on the left mouse button to 
lock the dimension in place. Click on the right 
mouse button to cancel the operation. 

  
 In the toobox, select  the Dimensions tab and from 
the dimensions browser select desired dimension 
then press the right mouse button to get the popup 
menu 
 
 

 
 

 
Delete a dimension 

Change the orientation of a dimension  

 

Delete all dimensions 

Set dimension label 

 
 

 
 

 
 

 
 
 

Move Dimension button 
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Saving a Project File 

To save a drawing structure to a file, on the toolbar click the Save File icon or from the File 
menu click Save. The default file extension for BEDAS is “BDS”. If this is the first time to 
save your work, the File menu Save As… dialog will be displayed. 
 

Exporting Beams Structure to Other Applications 
BEDAS exports files using the DXF format. This is the most popular CAD file format. To 
save a structure file in a DXF format, From the File menu click Export | to DXF. The 
current structure project filename suffixed with a DXF extension will be used as the 
exported file filename.  
 
BEDAS can also save a snapshot of the drawing area to a bitmap using the File menu 
Export | to BMP. The current structure project filename suffixed with a bmp extension will 
be used as the exported file filename. 

 
Computing dynamic analysis and/or mode shapes 

To compute dynamic analysis and/or mode shapes, from Compute menu click Compute or 
press F5.  
 
 

 
 

The Dynamic analysis dialog is displayed. This dialog is used to specify the type of 
analysis, the frequency max or the number of modes, the time step and the damping ration 
for dynamic analysis. There are two types of analysis: 
1) Mode shapes and vibration frequencies computing 
2) Dynamic analysis. 
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When computations are done, BEDAS switches to Result tab of toolbox. In this mode, you 
can view mode shapes animation and dynamic responses  

 
 

 
Printing 

 
Choose Print from the File menu 
 

 
 

For dynamics analysis you 
can input the damping ratio if 
it’s present in your structure. 
Damping coefficient is a 
percentage of the critical 
damping of the structure 
materials. Damping is 
considered a proportional 
viscous damping. 

22
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In Free vibrations computational and dynamics analysis you must input, the 
high frequency includes in the analysis or the maximum number of modes. To 
switch from the maximum frequency to the number of modes, clear the 
maximum frequency value and input the number of modes. Do the same to 
switch for number of modes to maximum frequency. 

Total time (s) of the dynamic analysis 
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Chapter 4 
 
 

Commands and Toolbars 
 
Users of BEDAS may use the icons on the toolbars to speed up access to some commonly 
used functions. Holding the cursor over an icon displays a tool tip describing the icon 
function. 
 

Main Toolbar (main toolbar is rotate to –90 degrees) 
 
New File 

Open File 

Save Current File 
 

Print graphical results 

Help 

Cut selected beams 

Copy selected beams 

Paste selected beams 

Delete selected beams 

                            Show and hide gridline 

Show and hide axes  

Show and hide points Ids 

Show and hide beams Ids 

Refresh graphics 

Show and hide materials colors 

Zoom in  

Zoom out 

Zoom window 

Zoom All 

Set automatically bounding box to fit all beams  

Zoom list 

 

Show and hide ruler 

Change units 

Set preferences 

Show and hide toolbox 

Results window 
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Toolbox 
 
The toolbox is displayed by clicking Toolbox in the View 
menu. The toolbox may be moved from right to left of the 
application window by double clicking its title bar or press the 
right mouse button. The Toolbox contains icons that perform 
various operations. These icons are grouped by topics under 
tabs. For example, the Geometry Input tab contains icons 
used to manipulate geometries. Some of the toolbox icons do 
not have corresponding menu items. 
  

Geometry Input  
The Geometry Input tab contains operations to create nodes, 
beams, arcs, circles, and boundary conditions and to delete 
nodes, beams, and boundary conditions. Also to view nodes, 
boundary conditions and merges nodes. 

 
Loads input 

The Loads input tab is used to add or modify loads and there 
properties and to verify the input load data. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Delete all loads, add standard vehicle, duplicate current load, add empty load 
and remove current load  

Load type: Concentrate, distribute, horizontal seismic and vertical seismic 

 Load direction in local beam reference: horizontal, vertical and bending 

+ 
_ 

2.  x0 
Start position 

5.  Speed=v 
Fi 

Path of current moving load 

1.  Length=width 
of distribute load 

t=0 

Tf = total time of 
the analysis 

3.  T0 

Start time of the 
current load 

4.  Duration 

time duration of the current load 

Current load expression in numerical value or mathematical expression, for 
load variation given in file (ex. seismic) type: “ File:”  to browse the filename 

Set load path from list box, view load path, set load path by mouse, view all 
loads, view current load, display graphics load variation, and apply changes 

Decrease or increase the animation speed of the visual simulation moving 
loads 

17.5*t*cos(1.57*t) 
x 

y 



                                                                                                                                                                                      28    
         BEDAS                             

 
MechaTools Technologies Inc  

Case of moving loads 
The sort in path beam list is import because the load move from the first selected to the end 
one. 
 
 
 
 

 
 
 
 
 

 
 
Case of moving loads – two loads in opposite directions  

In this section, we show how to set the loads path and properties for two opposite directions 
(see example in .../examples/3spans2.bds) 
 
 
 
 
 

 
 
 
 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
Case of fixed loads 

In the case of fixed loads it is important to set speed=0 and in the beam list of load path 
include just the beam where the load is applied. 
 
 
 
 
 

 
 
 
 

 

Path of current moving load 

Path beam number             1                        2                                        3                     4 

Beam number       7                6                         5                              4                             3                       2 

From the figure: the path beam list of the current load 
is  < 6   5   4   3 >, and the sort is very import  

Path of current fixed load 

Path beam number             1 

Beam number       7              6                         5                              4                             3                       2 

From the figure: the path beam list of the current fixed load is  <6> and 
the distance x0 is computed from the origin of the beam 

x0 

Path of the two moving load 

Path beam number             1                        2                                        3                     4 

Beam number       7                6                         5                              4                             3                       2 

From the figure: 
1.The path beam list of the load F1 is  < 6   5   4   3 >, 
the speed is v1and x0=0 
2.The path beam list of the load F2 is  < 3   4   5   6 >, 
the speed is –v2 (negative) and x0=l3 (length of  the 
first beam in the list (beam number 3).  
x0 is the start position 
 

F1 F2 v1 v2 

Node number                1                    2                              3                                4                   5                        

Use the up and down 
buttons in order to sort 
the path beam list in the 
desired and correct 
path 

v 
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Case of fixed distributed loads 
 
In the case of fixed distributed loads it is important to set speed=0 and in the path beam list 
of current load include just the beams where the load is applied. 
 
 
 
 
 
 

 
 
 
 
 

 
 
Standard Vehicles and trains 

In standard vehicles and trains dialog, you can select specific standards loads (vehicles) 
easily and quickly. In standards loads, when you set parameters, like speed, duration, initial 
applied time etc., these parameters are applied to all loads of the selected vehicle and if you 
delete one axle (load) of the selected vehicle, Bedas asks you if you want delete all the 
vehicle axles. You can add to the database your user-defined vehicles if there are not present 
in the list. To add user-defined vehicles permanently you will add them in an ASCII file 
named “Customveh.dat”. This file is present in you BEDAS folder. 
The format of the content of this file is: 
 
 
Number of vehicles                  //do not change the three first lines there are for guideline 
VehicleName, Number of axles/vehicle // 
Force, LoadType,  Idof,  length,  StartPosition,  Tinitial,  Duration1, Speed / for each axle  // 
2 
Custom3axles, 3 
-1000,"CONCENTRATE","V", 0,    0, 0, 10, 1 
-2000,"CONCENTRATE","V", 0, -10, 0, 10, 1 
-3000,"CONCENTRATE","V", 0, -20, 0, 10, 1 
Custom2axles, 2 
-4000,"CONCENTRATE","V", 0,0,0,20,2 
-5000,"CONCENTRATE","V", 0, -20,0,20,2 

 
 

    

First vehicle: 
Custom3axles 

Second vehicle: 
Custom2axles 

Path of current fixed load 

Path beam number             1                    2 

Beam number       7              6                              5                              4                             3                       2 

From the figure: the path beam list of the current fixed load is  < 6 5> 
and the distance x0 is computed from the origin of the first beam of the 
path beam list 

x0 
length 
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Seismic loads 

In BEDAS, user can perform seismic analyses due to a specific accelerogram (e.g. El-
Central etc.)  Alternatively, under the effects of an acceleration of the ground motion, in the 
form of mathematical expression a(t). The seismic excitation can be vertical or/and 
horizontal.   

 

 
 

CAD and Data 
 
The CAD and Data tab is divided in three categories. The first 
category contains operations to modify existing beams. The 
second category contains operations to change the bounding box. 
The last category is used display beam information windows. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Beams browser 

Modify beam, move all beams, move selected beam, 
transform selected beam, delete selected beam, color 
selected beam, select beams by mouse 

Set bounding box by mouse, set bounding box by values, 
show scrollbar, view beams coordinates table, show 
beams properties table, view beams material properties 

To specify a filename, 
write:  File:  and press 
return, Bedas gives you 
the possibility to browse 
your filename 
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Computing 
The Computing tab is used to execute and select the analysis type  

 
 
 
 

 
Dimensions and Label 
The Dimensions and Label tab contains operations to visually 
document the structure. 

 
 
 
 

Results 
The Results tab contains operations to visually view the mode 
shape, mode shapes animation, dynamic response and dynamic 
animation and more. 

                                                                
 

View dynamic response  in 
displacement, internal 
moment, shear effort and 
axial effort 

View loads with response, 
decrease, increase the visual 
amplitude of the internal 
efforts, decrease, and 
increase the visual line 
width 

View graphical time history 
of the numerical gage 
located at specific beam  in 
local position x/L (L is the 
beam length).  

Animation speed, view 
animate solution, view 
tabulated results. 

View beam mode shape 
info by mouse click, 

animate mode shape, 
and view tabulated 

results 

The Visual 
amplification response 

factor. You must 
increase this value if 
the visual solution is 
not visible, and you 

decrease this value if 
the visual solution is 

exaggerate. This factor 
may takes values from 

0.0001 to 10000 and 
more.  There is no 

influence on the real 
responses it is simply 

for drawing visual 
solution 

Static responses, Dynamic 
responses, and list of  time 
steps. 



                                                                                                                                                                                      32    
         BEDAS                             

 
MechaTools Technologies Inc  

 
Boundary conditions 

 
To set or modify the boundary conditions: 
 
 1. Press the boundary condition buttons. 
  
 2. Set the desired boundary conditions in the dialog 
 
 3. In drawing area, you select one node by clicking the mouse on 
the node or by selecting area that contains many nodes as in the 
structure  
 
 
 
 
 

 
 
              Boundary conditions applied to the selected area 
 

 
 

 
 
Menus 

BEDAS uses standard Windows menu for File, Edit and Windows operations. It also has a 
range of menus for working with structures and groups of beams. 

 
File Menu 

The File menu contains commands for creating, opening and 
saving structure project files. It also contains commands to 
print and export data.  
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New (Ctrl + N) 

Use New to start work on a new structure project. If you have unsaved changes to the 
current structure project, BEDAS will prompt you to save your work before starting the new 
project. 

Open (Ctrl + O) 
Use Open to open an existing structure project. If you have any unsaved changes to the 
current structure project, BEDAS will prompt you to save your work before opening the 
structure project. 
 

Save (Ctrl + S) 
Use Save to save the current structure project. 

 
Save As 

Use Save As to save the current structure project to a new file. 
 

Print  
Use Print to print the contents of the display area. 

 
Export  

Use Export to export the current structure project to a DXF file or to a bitmap file. The files 
are automatically created in the same directory as the structure project file (BDS). The file 
name used is the file name of the structure project except for the extensions (.BMP, .DXF). 
The bitmap file contains a view of the current drawing area. The DXF file contains the 
structure geometry. 
 

Exit  
Use Exit to exit the application. 
 
 

Edit Menu 
The Edit menu contains commands for copying and pasting tabular data, selecting objects 
and working in tables. 
 

 
 

Undo  
Undoes the last action carried out. Undo supports only one level of undo. When an action is 
undone, it may be redone using Redo.  

 
Redo 

This action redoes the last undo action. When an action is redone, it may be undone using 
Undo. 
 

Cut (Ctrl X) 
Remove the current selection and place it on the clipboard. (This info cannot be used 
outside the application) 



                                                                                                                                                                                      34    
         BEDAS                             

 
MechaTools Technologies Inc  

 
Copy (Ctrl C) 

Copy the current selection to the clipboard 
 

Paste (Ctrl V) 
Paste the contents of the clipboard into the current selection 
 

Delete (Del) 
Remove the current selection without placing it on the clipboard. 
 

Options Menu 
 

 
 

Preferences… 
Change the options to values that you would like to use for most beams that you will create 
in the future (ex comment, project number, company, client, colors, fonts etc.). 
 

Change Bounding Box 
 
Mouse 
Scale the drawing in the drawing area so that it just fits inside the window. 

 
Manually 
Set the maximum and minimum coordinates available in the drawing area. Use this to set up 
the overall coordinates before you begin drawing a structure. 
 

Change Units… 
Change the current units 
 

 
 
 

View Menu 
The View menu contains commands for controlling the display in the drawing area. 
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View Toolbox… 
To see or hide the toolbox 
 

Zoom 
Zoom in on part of the current display. Press the mouse button and dragging a rectangle 
surrounding the area of interest. Release the button to draw the zoomed view. 
 

Points 
Turn on or off the display of points numbering of the beams in the drawing area  

 
Beams 

Turn on or off the display of Beams numbering in the drawing area  
 
Ruler 

Turn on or off the display of rulers in the drawing, area, double clicking on the ruler, set the 
spacing of the grid and ruler 
 

Axes 
Turn on or off the display of axes in the drawing area  
 

Grid 
Switch on or off the use of the grid in the drawing area and set the spacing of the grid. 
 

Units… 
Change the current units 
 

View Dimensions 
Turn on or off the display dimensions in the drawing area  
 

Add Dimension 
Turn on for adding dimensions annotation in the drawing area  
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Show Beams Labels 

Turn on or off the display of Beams labels in the drawing area  
 
Beam Menu 

The Beam menu contains commands for working with Beams in the area 
 

 
 
 
Flip Horizontal (Flip about X Centroid) 

It reflects the selected beams about a vertical axis passing through origin or the centroid of 
the area of the selected beam. 

 
Flip Vertical  (Flip about Y Centroid) 

It reflects the selected beams about a horizontal axis passing through the origin or the 
centroid of the area of the selected beams. 

 
 

 
 

Transform beams 
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Duplicate 

This command duplicates the selected beam in the work area window a given number of 
times. In this case, you can duplicate beam by rotation, flipping, scaling or translating. 
 

Rotate  
It rotates all or the selected beams in the drawing window a specified number of degrees 
about the origin of the axes, the centroid or a specific point in the selected beam. A dialog 
allows you to enter the number of degrees of rotation. Rotation is positive anti-clockwise. 

 
Rotate Right 

Rotates all or the selected beams in a 90 degrees about the origin of the axes or the centroid 
of each beam. 

Rotate Left 
Rotates all or the selected beams in a -90 degrees about the origin of the axes or the centroid 
of each beam. 

 
Scale  

It multiplies the coordinates of the selected beam by a specified scaling factor in each axis 
direction. 

 
Translate  

It allows you to move the selected beam a specified distance this provides a more accurate 
way of moving beams rather than dragging them with the mouse. 
 

Get Length and Centroid 
Display the table of selected beam properties. 

 
 

 
 
Compute Menu 

 

 
 

Run… 
This command is to set materials, some parameters and execute properties calculations 
engine. 
 
 

Help Menu 
The Help menu contains commands for accessing BEDAS 's on-line he system. 
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About BEDAS  

It displays version information for this version of Beam Designer. 
 
 

Selecting the Type of Analysis 
 
The Dynamic analysis dialog is used to specify the type of analysis, the frequency max or 
the number of modes, the time step and the damping ration for dynamic analysis. There are 
two types of analysis: 
 

1. Mode shapes computing 
2. Dynamic analysis. 
 

For more info see chapter 3, Computing dynamic analysis and/or mode shapes section 
 

 
 
 

Computing  
The Apply button validates all input and modifying data for the type of analysis before 
allowing computation. If the validation is ok, the Compute button becomes accessible. 
Click Compute to begin computations. Some time when you input a time step, BEDAS 
check the value automatically and suggests to you a coherent time step value. You can 
accept or refuse the suggested value.  Some suggested value required a large number of 
steps (more than 5000 steps) so when you decide to accept the new time step check the 
number of steps in the warning dialog as fellow: 
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Result Mode 

 
When computations are done, BEDAS switches to Result tab mode. In this mode, you can 
visualize and animate solutions. You can view mode shapes animation, dynamic responses 
distribution in displacement, bending moment, shear and axial internal forces and you can 
also plot time history responses in specific positions on the beams.  
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Mode Shapes Results 
 

 
 
 

1. Check to visualize mode shape 

Press the button to animate the 
mode shape 

3. Current mode frequency info 

2.  Select mode shape from this list 

Check all mode  for accurate 
dynamic analysis, you can also 

select just some modes for special 
dynamic analysis 
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Beam mode shape info 
 

 
 
Mode shape info gives you the information about the analytical mode shape functions, the 
frequency, the nodal values of the current mode shape and the dynamic maximum responses 
in the selected beam by one click. 
 
The Mode shapes functions are: 

Bending: ( ) ( ) ( ) ( )
EI

A
xDxCxBxAv

ρω
αααααφ

2
4,sinhcoshsincos =+++=  

Axial: ( ) ( )
EA

A
xFxEu

ρω
αααφ

2
2,sincos =+=  

 

1. Check on in order to 
view mode shape info 

2. Click beam to view 
its mode shape info 
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Dynamic responses results 
 

 
 

 
 

Time History response in located gage: 
Dynamic response of the displacement v, in beam 11 at 

local position x=0.5*L 

In dynamic response you get 
automatically the DLF factor 

In Result mode, to view tabular results of 
the analysis, click View Tabular Results 

button. The Results dialog appear 

X=0 X=1 X=0.5 

Length=L 

The relative gage position in beam [0,1]= x/L: 

Beam i 
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Viewing tabular dynamic responses results 
 
The content of the Results dialog makes up the data that may be saved and/or printed. 
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        Equivalent visual results 
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                                          Equivalent visual results 
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Design verification 
The design of beams for specific applications is usually governed by detailed specifications 
and codes involving design requirements and procedures specific to each country. 
In BEDAS, you can verify your design by introducing your custom code equations. Bedas 
accept the mathematical input formulas to verify the design of your structure by applying 
the specified equations in an collection of criteria. Each criterion contains a mathematical 
equation that respects one criteria of the code design.  With this approach, BEDAS is a self-
update design criteria code.  If the country code changes, you can do it with the same 
BEDAS version without updating or purchasing a new version. From the Results dialog 
select the Design verification button, and the Design verification dialog appears 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

Current design 
Criteria number 

Add and remove 
design criteria 

Check all design 
criteria 

Results table 

The mathematical input design 
criteria: you must input left part 
equation, the operator and the right 
part equation. In criteria equation 
you must use only the variables 
contains in the parameters list 

Parameters list (list 
of available variables 
that we can use in the 
design criteria 
equation) 
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For example, for Dynamic amplification factor, we can input: 
 vmax/vmaxst in the equation criteria first part and in the equation criteria last part we can 
input the condition.  
You can also add new parameters by setting  the new parameter in the left part equation, the 
operator must be set to -> and in the right part equation input the value of your new 
parameter ( ex. Xnew -> 0.4).  After you input the new parameter you can used it in a new 
criteria  immediately (ex. Vmax<= xnew*Lbridge/360). You can not overwrite the original 
parameters. 
 
 

Saving tabular results 
In Result mode, the data contained in the Results dialog may be saved to disk using the 
button Save. This saves the data as a simple ASCII file using the name of the structure 
project and the .out extension as filename. The file is overwritten without warning. 

 
Printing Tabular Results 

In Result mode, the data contained in the Results dialog may be printed using the Print 
button. 

 
Viewing Graphical Results 

See Toolbox section and Results tab description 
              

 
 

  

Parameters list (list 
of available variables 
that we can use in the 
design criteria 
equation) 

When you click on the 
check button, the status 
column gives you the 
stat of the criteria: 
success or fail 
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Chapter 5 
 
  

Components and Tips 
 
 
 

General Geometric Shape   
 
The General Geometric shape component computes the geometric properties of predefined 
parametric beams. These properties are computed with respect to an arbitrary coordinate 
system. The beam drawing may be exported to BEDAS or any other client applications. 

 

 
 
Selecting a beam 

To select a beam type, click on one of the predefined beams in the General Beam tree 
of the Beam Type tab. Note that the Free Beam type is used to create a user-defined 
beam. When a beam is chosen, a detailed drawing of the chosen parametric beam is 
displayed. This drawing shows the customizable beam parameters.  
 

Entering parameters 
When a beam is chosen, the list of beam specific parameter with default values is 
displayed on the left and below the beam drawing. Parameters that do not apply to this 
beam are grayed out and inaccessible. Enter the beam parameters. 
 



                                                                                                                                                                                      50    
         BEDAS                             

 
MechaTools Technologies Inc  

Specifying the coordinate system 
Parametric beams are defined with respect to a beam specific coordinate system. This 
coordinate system is shown in red in the detailed drawing of the chosen parametric 
beam. To compute geometric properties with respect to an arbitrary coordinate system, 
specify the orientation and position of the coordinate system using the beta angle, Xc 
and Yc parameters. 
 

Computing Properties 
To compute properties, click Compute. The geometric properties are displayed in the 
Properties tab. The beam coordinates are displayed in the Data tab. 
 

Creating User-Defined Beams 
To create a user-defined beam based on an existing parametric beam, repeat the 
previous steps. After clicking Compute, select the Free Beam type in the General 
Beam tree. Instead of having a list of beam specific parameters displayed, a tabular 
editing control is displayed. The cells represent the x y coordinates of the points 
making up the polyline representing the beam. There are a tools bar buttons to add, 
insert and remove points or clear all entered data. 
                         
 

 
 
Note that you do not have to base a user-defined beam on an existing parametric 
beam. You may go directly to the Free Beam type and enter data from scratch.  
 

Exporting the Beam 
To export the beam geometry to BEDAS (or any other application using this 
component), click Apply. 

 
  

 
Printing 

If you want print your data and graphic beam, click Print button. 
 
 

Cells 

Enter data and 
validate by return key      

Tools bar buttons       
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Standards Beams 
The General Geometric Beam component displays the geometric properties of 
predefined standard steel beams. The beam drawings may be exported, using an 
arbitrary coordinate system, to BEDAS or any other client applications The General 
Geometric Beam component also supports multi criterion optimal beam selection. 
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Selecting a beam 
To select a beam type, click on one of the standard beams in the Standard Beam tree 
of the Beam Type tab. From the beam dropdown, select the specific instance of the 
beam type. When an instance is selected, a detailed drawing of the chosen beam is 
displayed. The Properties tab contains the properties of the selected beam. 
 

Finding an Optimal Beam 
To search for a beam that satisfies a series of criterions, select the Optimization tab. 
From the Beams tab, select the types of beams you want to search. From the 
Constraints tab, select the applicable constrains. This is done by checking one or 
more constraints and specifying the lower and upper value for each constraint. Click 
Optimize to search for the beams. Click on the Results tab to view the properties of 
all beams that satisfy the specified constraints. The valid beams returned and selected 
using the beams dropdown. 
 

 
 

Exporting the Beam 
To export the beam to BEDAS (or any other application using this component), 
specify the coordinate system, transform the beam to the new coordinate system then 
click Apply. 
 

Specifying the coordinate system 
Standard beams are defined with respect to a beam specific coordinate system. This 
coordinate system is shown in black in the detailed drawing of the chosen beam. To 
move the beam to a new coordinate system before exporting it, specify the orientation 
and position of the coordinate system using the angle beta, Xc and Yc parameters. 
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Transforming the beam to the new coordinate system 
Click Compute. 

 
Printing 

If you want print your data, graphic beam and return in report, click Print button (same as 
the general beam component) 

 
 
Beam Structure Optimization 

 
Optimization, give you many possibilities, the principal one is, that you can get one beam or 
more, by giving some constraints. Constraints can be applied to all the parameters and 
properties of the beam, to apply constrain to a parameter (ex. Area), you must input the 
upper and lower values, so the component looks for: 
Lower value <Area<Upper value and so for the other parameters. The other type of 
constraints is the type of beam, you must select one or more type of beams to applied the 
previous parameters constraints. If all necessary constrains are applied, press the Optimize 
Button, to see results press the Results Tab. See figure in Finding an Optimal Beam 
paragraph. 

 
Results can contain none or many beams that respect the constrains. List of results is given 
in the list box, in the Results Tab. From the list box, if you select a beam, you can see the 
corresponding properties in the list of properties 
 

 
 
The other utility of the optimization feature is: if you draw or import a custom structure, 
when you perform properties calculation, you can get the corresponding standard beam 
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which respect some bounded dimensions and properties of the original structure, this give 
you the possibility to replace the complicate (expensive) structure with an other standard 
structure and not expensive. 

 
 

 
Utilities  

 
 
From the toolbox, select Utilities tab. The utilities tab contains some 
utilities like, a useful Units converter component, which allows you 
the possibility to convert units at any time without searching in your 
handbook and other documents. 
 

Units converter  
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Chapter 6 
 
 

Techniques and Conventions 
 
 
 

Exact Dynamic Finite Element Formulation - Theoretical Background  
 

                           BEDAS Software 
 

 Beam-structure under  
Moving loads  

Free vibrations  
Natural frequencies/Modes 

. Traditional finite element model  
(Large number of elements per  

span)  
  

. Exact  Dynamic  finite element   
model ( DSM ) (One element per  

span) 

Dynamic Analysis 

Modal  Approach 

Model by  
Traditional FEM 

Model by  dynamic  
finite method ( DSM ) 

Uncoupled system 
FFT  method  
. Newmark type integration  
. Duhamel method 

Direct approach  
  

. Traditional finite   
element model 

. Time domain   
(Newmark method)  
. Frequency domain    
(FFT) 

 
Variational Formulation 

 
The weak formulation of virtual work expression of the transverse vibration of Euler-Bernoulli 
beam under moving loads for one element, is (we can do the same approach for the axial vibration 
as the case of Bedas): 
 

( ) ( ) dwdxtxFdwdxwEIdwwcdwwAdwW
LL

xxxxttt
e ∀=−++= ∫∫ 0,,,,,

00

ρ  (1) 

 
In free vibration, we take c and F(x,t) equal to zero. 

W e = δw, xxEI w,xx + δw ρA w, tt( )
0

L

∫ dx Then, the expression of W e  is reduced to the following 

form: 
 

          W e = EI δa P, xx{ } P, x[ ]0

L
− P, xxx{ } P[ ]0

L 
 
  

 
 a{ }     (2) 

 
We can now express the displacement w  and δw  in terms of the nodal displacement using:  

 

( ) ( ) [ ] { } ( ) { }nnnxxw wNwPP αα ,x== −1,           (Idem for δw )  (3) 
 

We can write the discretized form of W e  as: 
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       W e = δwn k ω( )[ ] wn{ }                (4) 
 

Where [k(ω)]  is the dynamic stiffness matrix.  
 

 
Free Vibration 

 
After assembling elementary dynamic stiffness [k(ω)] and elimination of rows and columns 
corresponding to the boundary conditions, the free vibration problem becomes: [Kd (ω)]{Xn}={0}. 
The solution of this non-linear eigenvalue problem is performed using Wittrick & Williams 
algorithm. Projection of the dynamic equation in the modal space is easily obtained and given by:  

 

                      )()()(2)( 2 tptyiyty jjjjjjj =++ ωωξ &&&          (5)

  
 

Where  pj(t) is the generalized load.   
For dynamics analysis you can input the damping ratio if it is present in your structure. Damping 
coefficient is a percentage of the critical damping of the structure materials. Damping is considered 
a proportional viscous damping: 
 

22
i

i
i

βω
ω
α

ξ +=  

 
The dynamic solution can be obtained by transforming the modal equation into frequency domain, 
using FFT technique: 

 

( ) )()(2 22 Ω=Ω+Ω+Ω− ffjjj PYi ωωξ .     (6) 

 
To determine the undamped frequency ωn for the continuous beam-structure, the number J(ω*) of 
frequencies of this structure exceeded by a fixed trial frequency ω*, is given by: 

 
                           J(ω*) = J0(ω*)+ s{Kd(ω*) }                                         (7) 

 
Where J0(ω*) is the number of frequencies that are exceeded by ω* if all degrees of freedom 

of the structure are clamped (displacements being constrained to zero) and s{Kd(ω*) is the 
number of negative diagonal elements in the triangulated dynamic stiffness [Kd(ω*) ] evaluated at 
ω =ω*. We use an iterative method like the bisection method, in order to converge to the true 
frequency.  Corresponding to each frequency ω, mode shapes of the rth span are defined by: 

 

φjr (xr)= Ajr cos αjrxr  + Bjr sin αjrxr  + Cjr cosh αjrxr  + Djr sinh αjrxr     (8) 
    

where φjr is the jth mode shape of the rth span (Figure 1) and xr is the local coordinate of the span 
r. We define the jth mode shape of the whole structure by: 
 

               )()( rjrj xX φ=Φ , Where: ∑
−

=

+=
1

1

r

i
irr lxX       (9) 

li is the length of the span i  
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Modal Approach 

 
The representation of equation (1) in modal space leads to a set of uncoupled relations. For each 
element, the modal representation of transverse deflection is: 
 

)()(),(
,1

tyXtxw j
nj

rjr ∑
=

Φ=           (10) 

 
Using equations (10) and the orthogonal properties of modes in equation (1), we obtain: 
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Frequency Domain Response 

 
The solution can be more easily obtained by transforming equation (11) into the frequency domain, 
using Fourier transform technique: 

∫
+∞

∞−

Ω−=Ω dtetpP ti
f ).()( ; ∫

+∞

∞−

Ω−=Ω dtetyY ti
f ).()(      (13) 

∫
+∞

∞−

Ω−=ΩΩ dtetyYi ti
f ).()( & ; ∫

+∞

∞−

Ω−=ΩΩ− dtetyY ti
f ).()(2 &&                                      (14) 

 
Using equations (13) and (14), equation (11) becomes: 
 
 

( ) )()(2 22 Ω=Ω+Ω+Ω− ffjjj PYi ωωξ      (15) 

 
Thus the solution in the time domain is 
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yj(t) = 1
2π

Yf (Ω) eiΩt dΩ
-∞

+∞

      (16) 

                        

yj(t) = 1
2π

i Ω Yf (Ω) eiΩt dΩ
-∞

+∞

 

                      

yj(t) = 1
2π

- Ω 2 Yf (Ω) eiΩt dΩ
-∞

+∞

   

We should choose the time period T2 large enough to cover the response characteristics of the 

system:    ∆t =T2 /N; T2 =T1 +T;  T1= 2π/ω1          

Where T1 is the fundamental period of the structure and T is the period of the excitation load. In 

order to discretise the pulsation interval Ω, we use ∆Ω= 2π /  T2   

With  0=Ω=Ωmax= 2π/∆t  where Ωmax  is the Nyquist pulsation. The choice of ∆t is such that fs 

=1/2∆t where fs is the highest frequency present in the signal and participating in the response of 

the structure. One should verify that:     ∆t= 1/2fmax      

The discrete representation requires a judicious choice of T2  and N, which defines ∆t, ∆Ω. One 

may remark that the time and pulsation are divided into N steps. 

 

 To obtain a very good approximation of the displacements, velocities and accelerations, we 

must evaluate the generalized loads pj(t) in exact procedure, because the transfer function between 

loading pj(t) and displacement yj(t) is generated analytically by equation (15).  

 
 
Representation of the Excitation Loading 

 
In the following cases, we assume that the level of the moving or fixed impulse load Fi  could be 
given in the general form as: Fi  =Fi (t). We assume the same equation for the distributed moving 
or fixed load qi .  
 
 

Moving Multi-axle Loads 

 
The generalized load for the moving multi-axle load case (Figure 1) is:  
 

∑∫ ∑
==

Φ∆=−Φ∆=
nli

iiijj

L

nli
iijjj txFxdxtxFxxxtp

,10 ,1

),()(),()()()( δ   (17) 

 
Where x =vi t, and vi is the speed of the moving load Fi. If the load Fi  is on the span s, we have:   
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Φj(xi) Fi = φjs(xs) Fi                                             (18) 

∑
−

=

−=
1

1

nc

r
rncs lxx  

 
xnc  is given in function of the position of the first load by  
 

∑
−

=

−=
1

1
1

nc

j
jnc axx           (19) 

 
 With aj is defined as the relative position between the loads Fj  and Fj-1  (Figure 1). 
 

 

                      

xm

xi
F i

span mspan m-1

lm-1 lm
 

 
Figure 1: 2D framed bridge under multi-axle moving loads 

 
 
 
 

 Moving Distributed Loads 

 
The generalized load is given by: 

∑ ∫ ∑∫
= = 










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p
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,1 0 ,10
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If the distributed load qi  is on the span s, we have:  
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coshsinhcossin

),(
0 ,1

++−

=∫ ∑
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(21) 

 
Where xup, and xlo are given in Figure 2. 

 
Figure 2: The upper and lower boundary of the integral of equation 21. Case of distributed moving 
loads 
 

 
 
Internal Forces Computation 
 
Because the approximations of the modal responses (frequencies and mode shapes) are very good 
using a dynamic stiffness approach, the internal forces are obtained in a very good way for any 
structure in the span and for any time. 
Bending moment in the rth beam at xr location and at any time t is given by: 
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Shearing force in the rth beam at xr location and at any time t is given by: 
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It will be necessary to include more modes to define the internal forces to any desired degree of 

accuracy than to define the displacements; their contributions become more significant for moment 
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response and even more significant for shear.  Therefore, one should be careful when limiting the 

number of lower modes in estimating response. 

 
 
 
 
The Flexure formula 
 
The fiber stresses at the extreme (i.e. top and bottom) fibers may be written, respectively, as: 

r

r

r

r
r
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x S

txM
y

I
txM

tx
1

max
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),( −=−=σ  

r

r

r
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txM

tx
2
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),(),(
),( −=−=σ  

Where, I is the moment of inertia about neutral axis and the quantity S is called the elastic section 
modulus of the r current beam cross-section. All these quantities are computed in BEDAS, and can 
be used in the design verification dialog, including the maximum dynamic values in displacements, 
rotations, velocities, accelerations, internal efforts, dynamic amplification factors and the 
maximum dynamic responses. 
 

 
 
Dynamic amplification factor (DAF) - DLF 
 
In Bedas the dynamic amplification factor is computed as fellow: 

 DLF (or DAF) = maximum dynamic response/ maximum static response 
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Static (Quasi-Static) Response  
 
With the exact dynamic stiffness approach, we can also obtain easily the static response in very 
good agreement. We assumed that the inertial and damping effects vanish, so the modal equation 
(11) becomes: 

   )(),()()()(
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Moreover, the modal static response is:  2
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With pj is the generalized force of the static load F(x,t). The physical response w(x) is given by 
equation (10). We take the example of a simple pinned-pinned beam under a constant force F 
applied at the mid-beam at x=L/2, the mode shape and the frequency of mode j are given by: 
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From equation (12) Mj2=L/2. We obtain:  
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Finally, from equation (18) the physical response w(x) is given by: 
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And the maximum static response of the beam is obtained at x=L/2:  
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If we take the first seven participate mode (j=7), we find  
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So, if j (number of mode) is high, w(L/2) converge to the analytical value:   
EI

FLL
w

48
)

2
(

3

=  

 

In dynamic problems under the influence of base excitations, usually the number of modes 

considered must contribute to a total mass participation factor of at least 80-85% of the system mass 

in the direction of the base motion. 

For harmonic and random vibration problems, in addition to the 80-85% mass participation factor 

requirement, the range of natural frequencies considered for the analysis must cover the highest 

frequency in the excitation. 

 
 
Report Problems or Errors 

 
To report problems or errors, please record the exact steps that lead up to the problem so that we 
may reproduce the condition. 
Email or fax these steps to our technical support. Any additional information that may be relevant 
to locating or verifying the problem is appreciated. 
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Examples:  
 

1.Mode shapes and frequencies calculation of 2D beam structure  
   (In folder ../examples/ Struct2D.BDS) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
EI=5.0x106 N.m2 

EA=9.0x108 N 
m=35 Kg/m 
 

 
 

 

 Mode number 

Standard Finite element I 2 3 4 5 

NNODES NDOFS Frequency (Hz) 

6 
9 

24 
33 
43 
51 
60 

14 
45 
72 
99 

126 
153 
180 

26,373 
26,796 
26,088 
25,823 
25,898 
25,630 
25,587 

52,291 
38,711 
39,592 
39,592 
39,556 
39,528 
39,509 

62,121 
46,050 
48,577 
48,899 
48,992 
49,030 
49,050 

72,541 
52,116 
52,583 
52,569 
52,537 
52,513 
52,497 

86,218 
63,259 
66,519 
66,761 
66,779 
66,771 
66,761 

69 207 25,471 39,447 49,092 52,442 66,715 
  

Mode number 
BEDAS  I 2 3 4 5 

NNODES NDOFS 
Frequency (Hz) 

6 I 14 25,4676 39,4660 49,1172 52,472 66,7489 
 
NNODES=Number of nodes, NDOFS= Number of degrees of freedom 
 
 

3 

4 4 

1 

2 

3 

4 

5 

6 
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2. Multi-span beam under a moving load (in folder ../examples/ 3spans.BDS) 
 
Example of continuous beams under a single moving load. We study the  
dynamic responses for speed v=35.57 m/s, using one element per span (only 
three elements for the bridge).   
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

   
 
 
 
 
 
 
 

Mode number 
 

Frequencies (Hz) 
 

Structure  properties 

 

L = 60 m   

ml = 1.0 x103 kg/m 

A = .51 x10-2 m2          

EI = 1.96 x 109  N.m3    

E = 10.48x10 10 N/m2  

F = 9.8 x103 N  

 
 
 
 
 
 
 

1 
2 
3 
4 
5 
6 
7 
8 
9 

       10 

6.204 
7.581 

11.974 
21.163 
24.207 
26.439 
37.282 
53.579 
56.642 
64.130 

L 
L/3 L/3 L/3 

EI, ml 2EI, ml EI, ml 
F 

v 
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3.Dynamic of Multi-Span Bridges under the effects of high speeds moving train 

 
We study the dynamic response of three different bridges under the effects of the high 
speeds moving train (TGV).   
 

 
 

 Geometry of typical bridge structure 
(dimensions in [m] for La Lys Bridge). 
 
 
 

The vehicles used in these analyses are the French 
TGV train, which composed of two cars (the power 
car and trailers for each car) as shown in figure.  In 
this case, the series of loads has 60 axles of 17 tones 
for each axle, and the train speed varies from 150 
km/h to 400km/h in order to determine the critical and 
sub-critical speeds and the vehicle-bridge response 
characteristics.  The elastic modulus used in the three 
cases of bridges is 2.1x1011 MPa. 

 
 

 
 

 

      
The dimensions of the one car French TGV 

 
 
 
 
 
 
 
 
 
 
 
 

For the geometric properties of 
the composite section, we used 

our ShapeDesigner software 
www.mechatools.com 
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3.1. LA LYS Bridge (in folder ../examples/ LYS.BDS) 

 
Problem Description 

 
The LA LYS Bridge is a fast speed train 
(TGV) railway bridge. The viaduct is a 
continuous bridge of three spans (30.20 m-
53.20m-30.20m), of 113.6 m length and four 
structures kinds.  Structure 3 is a cracked 
concrete region, and the modular ratio between 
steel and concrete elastic modulus taken in this 
example is 10 under live loads. The coefficient 
of damping is taken equal to 0.5% of the 
critical damping; the train speed varies from 
150 to 400 km/h and the viaduct is simply 
supported. 

 
Sections 1 2 3 3 cracked 5 
ρ [kg/m3] 

A [m2] 
J [m4] 
Iz[m4] 

51610.0 
0.67352 
0.6500 
0.9144 

45549.0 
0.7774 
0.6605 
1.3067 

42765.0 
0.83948 
0.6622 
1.5249 

80917.0 
0.41784 
0.6622 
0.8587 

48794.0 
0.72018 
0.6533 
1.2572 

 
         Properties and material data of the LA LYS bridge structure 
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Dynamic response in central mid-span, v=300 km/h.  Vertical displacement, LA LYS Bridge. 

 
 

3.2. BANCEL Viaduct  (in folder ../examples/ Bancel.BDS) 
 

Problem Description  
 

The BANCEL Viaduct is a fast speed train (TGV) railway bridge. The viaduct is a continuous bridge of 
five spans, a length of 218 m and 3 structures kinds. Structure 3 is a cracked concrete region, and the 
modular ratio between steel and concrete elastic modulus taken in this example is 10 under live loads. The 
coefficient of damping is taken equal to 0.5% of the critical damping, the train speed varies from 150 to 
400 km/h and the viaduct is simply supported.  
 

 
 

Sections  1 2 3 
ρ [kg/m3] 

A [m2] 
J [m4] 
Iz[m4] 

6447.5 
4.532 
0.410 
1.215 

80495.9 
0.363 
0.410 
0.665 

60622.4 
0.482 
0.410 
0.964 

          
             Properties and material data of the Bancel bridge structure 

 

Mode 
number 

Frequencies 
(Hz) 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

2.1417 
4.7135 
5.3843 
7.9452 
14.774 
18.463 
26.964 
37.076 
40.660 
44.419 
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-6,0 10 -3

-4,0 10 -3

-2,0 10 -3

0,0 10 0

2,0 10 -3

4,0 10 -3
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em
en

t [
m

]

Time [s]

 
 

 
Dynamic response in central mid-span, v=300 km/h.  Vertical displacement, BANCEL Bridge. 

 
 

3.3. LA SCARPE Bridge (in folder ../examples/ Scarpe.BDS) 
 

Problem description 
 

 The LA SCARPE Bridge is a fast speed train (TGV) railway bridge. The viaduct is a continuous bridge 
of nine spans, and length of 333 m, 4 structures kinds. In figure below, structures 3 and 4 are cracked 
concrete regions, and the modular ratio between steel and concrete elastic modulus taken in this example 
is 10 under live loads. The coefficient of damping is taken equal to 0.5% of the critical damping, the train 
speed varies from 150 to 400 km/h and the viaduct is simply supported.. 

 
Sections  1 2 3 4 
ρ [kg/m3] 
A [m2] 
J [m4] 
Iz[m4] 

46350.0 
0.63 
0.40 

0.586 

44930.0 
0.65 
0.40 

0.686 

93500.0 
0.313 
0.40 

0.390 

88500.0 
0.330 
0.40 

0.450 
 
Properties and material data of the LA SCARPE bridge structure 

Mode 
number 

Frequencies 
(Hz) 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

2.108 
2.634 
3.382 
4.341 
4.588 
7.683 
9.026 
10.572 
13.730 
14.133 

-6,0 10
0 1 2 3 4 5 6 7 8
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]

Time [s]
 

0 2 4 6 8 10  
 

Dynamic response in central mid-span, v=300 km/h.  vertical displacement, LA SCARPE Bridge. 
 
 
•The critical speeds Vcr are determined by supposing the predominant frequency of loads is 

function of distance d between the 2 successive axles 

 • d=18.7m for one car TVG and  Vcr = d/Ti, where Ti is a given period 

• the critical speed produce the maximum response  

 
 
 Vcr(Km/h) fcr(Hz) Near Mode 

Bancel 295 ( 81.94 m/s) 4.38 4th 
Scarpe 290  ( 80.55 m/s) 5.57 7th 

LA LYS 375  (104.16 m/s) 4.30 3rd 

Mode 
number 

Frequencies 
(Hz) 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

2.174 
2.366 
2.660 
3.027 
3.438 
3.860 
4.222 
5.219 
6.439 
8.090 
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Input and Output Files 

 
Input File 

 
The BEDAS input file, is a common ASCII file with extension “BDS”. Its structure is 
simple and intuitive. An example is given below: Words in bold are a BEDAS 
keywords you cannot change any keyword. 
 

 
M E C H A T O O L S    S T U D I O 1.0 

 
**************************************** 
*              BEDAS 4.0               * 
*                                      * 
*    Dynamic Analyses of Structures    * 
*     And Bridges under Fixed and      * 
*              Moving Loads            * 
*     MECHATOOLS TECHNOLOGIES© 2004    * 
**************************************** 

 
Version 
BEDAS 4.0 
COMPANY 
Your Company 
CLIENT 
Your Client 
PROJECT 
Your Project 
TASK 
Your Task 
PREJECT-REFERENCE 
You References 
ENGINEER 
ING1 
ZOOM 
 1.5 
XMAX 
 12.3577 
XMIN 
-.975609 
YMAX 
 11.5447 
YMIN 
-1.78861 
FREQUENCYUP 
 0 
DAYNAMIC PROPBLEM DURATION 
 2.5 
DAYNAMIC TIME STEP 
 .00965251 
DAMPING MODE I 
 1 
DAMPING MODE J 
 2 
DAMPING KSI I 
 0 
DAMPING KSI J 
 0 
LOADS 
 1 

LOAD 
 1 
LOAD TYPE 

CONCENTRATE 
LOAD LENGHT 
 0 
FORCE EXPRESSION //F(t) 
-9480 
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SPEED               // v       
35.57 
STARTPOSITION       //x0 
 0 
DOF  
V 
DURATION FORCE     //duration 
 2 
INITIAL TIME FORCE //F(t) 
 0 
TOTAL BEAMS LOADED //Path beam list 
 3 
 1 
 2 
 3 

COORDINATES 
 2 
00.00000E+00  // x1 
-35.52714E-16 // y1 
110000        // boundary conditions u=0,v=0  
60.00000E+00  // X2 
-35.52714E-16 // y2 
010000        // boundary conditions u free, v=0 
BEAMS 
 1 

BEAM 
1 
COLOR 
 65280 
TYPE ID 
 1 
FILENAME 
 
EXT_FILENAME 
 
MASS AREA 
 3921560 
MASS DENSITY 
 196078 
MASS LINEAR 
 999.9978 
IX 
 .0187 
AREA 
0.0051 
MATERIAL 
User-Defined 
ELASTIC MODULE 
 104800000000 
SHEAR MODULE 
 0 
POISSON COEFFICIENT 
 .27 
COLMASS 
 0 
COLYOUNG 
 0 
FIRST POINT 
 1 
SECOND POINT 
 2 

COTATIONS 
 1 

COTATION 
1 
P1 
 0 
P2 
 2 
DELTAX 
 21.1151724466463 
DELTAY 
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 5.7196027057927 
ORIENTATION 
 1 

LENGTH UNIT 
 4 
m 
MASS UNIT 
 1 
kg 
STRESS UNIT 
 2 
Pa 
FORCE UNIT 
 1 
N 
 
END 

 



76     
         References 

 
MechaTools Technologies Inc  

 
Output File 

The BEDAS tabulated results Output file, is a commonly ASCII file with extension 
“.rst”. Its structure is simple. An example is given below. You can get also graphical 
results by choosing print from toolbar in the current activate window. And the 
problem execution information output file is a commonly ASCII file with extension 
“.out” 
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